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The Rules of Velcro 
When using Velcro in your classroom remember these tips to ensure success. 
 
Male Velcro—otherwise known as HOOK Velcro “travels around”. Use this on the back of 
symbols, manual boards, or small single-message devices you are going to mount some-
where. 
 
Female Velcro—otherwise known as LOOP Velcro “stays at home”. Use this Velcro on 
walls, desks, laptrays, folder games, etc. It will serve as a home for the symbols and 
manual boards. 
 
**When cutting adhesive backed Velcro, hold it with the Velcro side down and the back-
ing side up, this will cut down on the adhesive buildup on your scissors. 
 
Some vendors that sell Velcro in bulk are (call for current prices): 
Lockfast-South      770-422-7122 
Mayer-Johnson Company    800-588-4548 
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Everyone Benefits from Visual Strategies 

 
Picture symbols are frequently used for communication on electronic devices as well as manual     
communication boards. Symbols placed strategically around the classroom can also be used to provide 
communication opportunities for nonverbal students. However, use of picture symbols can benefit all 
students in the classroom, even those that talk. 
 
Visual Strategies help students: 
 Attend better     Recall information 
 Know what’s expected   Expand language 
 Organize information   Learn 
 
For example, visual strategies: 

 Help students recall and relate an activity that has already happened. Such as something the 
student did over the weekend (home-school communication book). 
 Allow students with word finding difficulties retrieve words when in conversation with an adult 

or peer.  
 Help students maintain their focus on an activity such as morning circle, by  

      having activity related picture symbols in front of them. 
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Everyone Benefits from Visual Strategies (cont.) 
 

 Promote verbal interaction with peers. 
 Allow students to anticipate what will happen next (picture schedule). 
 Help students remember the sequence of an activity such as a classroom job. 
 Provide a visual stimulus for more complex spoken language from students who have limited 

verbal output. Organizing pictures on a display to follow basic sentence structure (subject-verb-
object) allows them to create more complex utterances. 
 Assist students who have difficulty processing and comprehending information in organizing 

their spoken responses. 
 When used with storybooks, picture symbols help students remember main characters and    

actions and serve as visual cues when they are asked to relate parts of the story. 
 
In order to be successful, visual tools must be: 
• Easily recognized 
• Easily understood 
• Accessible 
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Boardmaker Version 5 (PC only) Quick Start 
Creating a board using a premade template: 
1. Insert Boardmaker CD into drive. 
2. Double click alias on desktop or access through the hard drive. 
3. Once program opens, select “Open a template”. 
4. Scroll through and select the template you need. 
5. Once template is open, go to “Save as” under the File menu and name your board. Click 

Save. Boardmaker automatically saves things you create in the My Boards folder which is 
located in the My Documents folder. 

6. Select the Symbol Finder Tool (the silly face) to begin pasting pictures in your template. 
7. To search for a symbol, type the word in the Search Text Field. Use the white forward and 

backward arrows to scroll through the found picture set. You can also use the Thumbnails 
Button (bar with the square, circle and triangle) to view all the selections at once.  

8. Once you decide on the picture click in the cell you want to paste it into 
or 
if the cell is already outlined in red, pressing the enter key on the keyboard will  
automatically paste the picture there. 

9. Repeat steps 7 & 8 until all the cells are filled. 
10. Print your overlay making sure paper size and orientation are right for the template used. 
(continued on back) 
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Boardmaker Version 5 Quick Start (cont.) 
Miscellaneous Tips... 
There are two ways to change the text above symbols: 
1. You can use the Alternate Symbol Name Field in the Symbol Finder by typing in the alternate text. 

This will only change the text for the symbol you are pasting into the template and will not change 
the original. 

2. In the Draw Window, select the Text Tool in the Tool Palette, click on the text to highlight, and type 
in the new text. 

 
Changing the color of objects: 
1. In the Draw Window, select the Pointer Tool from the Tool Palette, select the symbol you want to 

change on your template.  
2. The Paint Tools Palette will be displayed. Choose one of the Fill Tools (paint bucket). The Fill Tool 

fills only the area selected and the Fill All Tool fills all like colors in the symbol. When the program 
asks if you want to convert the symbol to a bitmap click “Yes”.  

3. Select the Color Tool and choose a color from the palette. Position the tip of the paint coming out 
of the Paint Can over the area to be filled and click. 

 
Adding 2 or more symbols to a cell: 
If you try to place a second symbol in a cell you will get a message that asks if you want to replace the 
current cell or add to it. Select “add to” and the symbol is added to the cell. Use the Pointer Tool to 
 resize the symbols for a better fit. 
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Importing Old Windows Boards into Boardmaker Version 5 

Follow these steps to import old windows boards into the new version of Boardmaker. 
With Boardmaker open: 
♦ Under File go to import and select Windows Board 
♦ A screen will appear with two options: 
 

♦ Import One Board—this opens the selected “old” board into an untitled window.                
Double click on the board you want to open; then name the board and save it in the My 
Boards folder (usually found in the My Documents folder). 

 
♦ Import an Entire Folder—this converts an entire folder of  “old” boards which can then be 

opened in the usual way. 
In the Browse for Folder window locate and click on the folder of boards you want to  
convert. Click on the OK button to start the conversion process. The newly converted boards 
will have their original names followed by a “.bm2” file extension. The converted boards will 
be saved in the same folder as the originals. You may want to move them to your My 
Boards folder. The converted boards can now be opened in the usual way. 
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Creating a Boardmaker File with Multiple Pages 

1. Open Boardmaker program and maximize window. 
2. File  Open and open the premade grid you want to work with. 
3. View  select Reduce to Fit. 
4. File  Print Setup (Page Setup on a Mac). Check to make sure the settings are correct for your grid 

(portrait/landscape orientation and regular/legal size paper.) 
*For Boardmaker 5.0 stay in this window and replace the numbers (in boxes) indicating width and 
height, with the values to their immediate right (maximum column). Click OK and go to    step 6. 

5. Preferences  Board Size. In the open window replace the first column of numbers (in boxes) indicating 
width and height, with the values to their immediate right (maximum column). Click OK. 

6. The window will have black dotted lines (red on a Mac, green on 5.0) indicating the multiple pages. 
7. Edit  Select All  (this will select the grid). 
8. Edit  Copy (this will copy the grid). 
9. Edit  Paste (this will paste the copy on top of the original grid) 
10. Click and drag “new” grid to one of the blank pages. 
11. Repeat steps 9 and 10 until all pages are filled with a grid. 
12. Add symbols to grids. 
13. To print, keep in mind pages are numbered left to right and top to bottom. You can print all of the pages 

or just one. 
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Creating a Boardmaker File with Multiple Pages 
(continued) 
This is an example of what the window might look like when all the grids have been pasted on the 
pages. 

 
***You can also make a file with multiple 
pages containing different grids.  
However, this involves opening and  
closing the various grids in order to copy 
and then paste them into the new  
document. 
 
Using the above idea you could make 
grids for an activity such as the book 
Brown Bear, Brown Bear for several  
different devices. 
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Adding Internet Pictures to Your Boardmaker Libraries 
PC 5.0 
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1. Open Boardmaker. 
2. Click on the Symbol Finder Tool (funny face) to go to the libraries. 
3. Open your Internet Browser (Internet Explorer, AOL, etc.) 
4. You can use one of the many search engines that are good sources for images (Google, AltaVista, 

etc.) and type in the item you are looking for or you can go  
directly to a specific website (Wendy’s, Fisher-Price, etc.) to find images.  
Amazon.com is another good source for realistic pictures of books, toys and videos 

5. Once you find an image, move the cursor over the picture and right-click with your mouse. A 
menu will open up, select COPY. 

6. In the active Boardmaker window select Paste under the Edit menu, the My  
Symbols window will open. 

7. Below the Add a Name box type in the name of the picture and click on Add a Name. 
8. Next click on Assign Categories and check all categories that apply. When finished click on OK. 
9. Click OK again to leave the My Symbols window. The new picture should now  

appear in the Symbol Finder window. 
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1. Open Boardmaker 
2. Create a grid or open a pre-made grid 
3. Open your Internet Browser (Internet Explorer, AOL, etc.) 
4. You can use one of the many search engines that are good sources for images (Google, Alta-

Vista, etc.) and type in the item you are looking for 
 

Or 
 

5. You can go directly to a specific website (Amazon, Wendy’s, Fisher-Price, Barnes and Noble, 
etc.) to find images 

6. Once you find an image often you can get to a larger image by clicking on the small one or se-
lecting “see a larger image.”  (This will allow you to copy an image with better detail) 

7. Once the larger image opens, right click the image, a menu will open 
8. Select COPY 
9. (Some images do not open in a larger view, you can right click the small view to copy it)  

10. You can paste the copied image into a Boardmaker grid by 
11. Clicking on a cell to select it (a dotted red line will appear to show it is selected) 
12. From the Edit menu, select PASTE 
13. The picture will be pasted into the cell 
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Adding Internet Pictures to Your Boardmaker Libraries 
Cont. 

14. If needed you can resize it and/or move it 
15. To type a label over the symbol, select the “A” tool  
16. Click in the cell and type the label 
17. Select the arrow tool, click on the label to select it 
18. Click and drag the label to center it over the picture 

If you think you will use the image again and want to save it in your Boardmaker libraries 
 

1. Follow steps 1-9 
2. When you go back to Boardmaker 
3. Select the symbol finder window 
4. Select PASTE under the Edit menu 
5. The My Symbols window will open 
6. Below the Add a Name box type in the name of the picture and click on Add a Name. 
7. Next click on Assign Categories and check all categories that apply.  When finished click on OK. 
8. Click OK again to leave the My Symbols window.  The new picture is now in your Boardmaker 

libraries and will come up when searched for. 
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More BoardMaker Tips & Tricks             pg. 1 

Here are some other ways to use BoardMaker more effectively and efficiently. These tips assume that the 
user already has a good working knowledge of the program. 
 
Saving Newly Created Symbols 
After creating a “new” symbol in BoardMaker (making changes to a current symbol or combining symbols  
in a cell) you can save it to the library and then you’ll have it the next time you want to use it. To save  
it, select all items in the cell except the text. Using the arrow tool click on the first item, then  
holding down the shift key click on the additional items until all are selected. Go to Edit and select  
Copy. Open the Symbol Finder Window, go to Edit (it will be grayed out but you can still select it) and  
select Paste. The My Symbols Window opens. Type the name of your new symbol and click on Add a  
Name. Then click on Assign Categories and choose at least one category for your new symbol, click  
OK. Click OK again to exit the My Symbols Window. 
 
Quick Way to Search for Pictures in a Category 
Go into the category window by clicking on the category bar and selecting clear all categories. Then  
click in the box next to the category you want, such as “Animals”. Click OK. Now you can click on  
the display thumbnail view bar (3shapes) which opens a window with just the symbols for the category  
you selected (use the arrow buttons to scroll through the symbols in this window). You can quickly  
add the symbols to your template by right clicking on the symbol. It will be placed in the template  
square with the red border. If you want more control of symbol placement, left click the symbol and  
then click in the cell where you want the picture. 
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Deleting Pictures from the Libraries  
To delete pictures from the libraries (i.e. pictures of students no longer in your classroom), open the  
Symbol Finder Window and do a search for the picture so it appears in the Symbol Finder Window. Go  
to Edit and select Cut and the symbol will be deleted from the library. 
 
Quick Way to Delete Pictures & Text from a Template  
When deleting a picture from an overlay the program has a warning that asks if you really want to  
delete the item selected. To eliminate this step and several keystrokes select the cell(s) and under  
Edit choose Clear. This will clear all items from the cell(s) selected. 
 
To Change the Font/Size in All Cells 
In the template window click and drag an imaginary box that touches all cells (they should all have a  
green border) or go to Edit and choose Select All. This will select all the cells. Go to Text and  
choose Font. This will open the Font window and you can now choose the font and size of your  
text. Click OK and the text in all cells will be changed. 
 
Quick Way to Add Symbols to Templates 
With the display thumbnail window open you can right click on the symbol you want and the symbol is       
automatically added to the cell with the red border. This works well when you are be creating individual 
symbols and don’t need to worry about what order they are in on the page since they will be cut apart. 
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More BoardMaker Tips & Tricks               pg. 3 

To “Lock” a Board/Template  
You can use this feature to protect an overlay or template that you’ve created from being changed. After 
completing your overlay, go to File, select Save and name your board/template. Close the file. Go back into 
your My Boards folder and right click on the file name. A menu will open, select Properties. The file  
properties window opens. Check the box next to read only and click Apply. 
 
Sharing Boards with Others 
Did you know you can email boards? It’s a great way to share the things you’ve created with others. If 
more people did this it would save a lot of time and energy for everyone. Just open an email and attach 
the boards you want to send. The receiving person must have BoardMaker on their computer or they 
won’t be able to open them. 
 
Using BoardMaker without the CD in the Drive 
While using BoardMaker, should you need to use your CD drive for a different  CD (to listen to music  
or to work with files), as long as you keep the program open on your desktop you can remove the  
BoardMaker CD and the program will still work. 
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To “Lock” a Board/Template  
You can use this feature to protect an overlay or template that you’ve created from being changed. After 
completing your overlay, go to File, select Save and name your board/template. Close the file. Go back into 
your My Boards folder and right click on the file name. A menu will open, select Properties. The file  
properties window opens. Check the box next to read only and click Apply. 
 
Sharing Boards with Others 
Did you know you can email boards? It’s a great way to share the things you’ve created with others. If 
more people did this it would save a lot of time and energy for everyone. Just open an email and attach 
the boards you want to send. The receiving person must have BoardMaker on their computer or they 
won’t be able to open them. 
 
Using BoardMaker without the CD in the Drive 
While using BoardMaker, should you need to use your CD drive for a different  CD (to listen to music  
or to work with files), as long as you keep the program open on your desktop you can remove the  
BoardMaker CD and the program will still work. 
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Boardmaker related websites: 
 

Sources for pictures: 
 
www.awesomeclipartforkids.com 
www.barrysclipart.com 
www.amazon.com 
http://school.discovery.com/clipart 
http://barnesandnoble.com/ 
http://pics.tech4learning.com 
http://www.google.com (click on images) 
http://dgl.microsoft.com 
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Boardmaker related websites (cont’d): 
 

 
Pre-made materials to download: 
 
http://www.ese.ocps.net/ (OCPS Assistive Technology link) 
http://speakingofspeech.com (materials exchange) 
http://www.mayer-johnson.com (downloads) 
http://card.ufl.edu/visual/start.html  (practical tips) 
http://www.do2learm.com (activities) 
http://aacintervention.com (tips and links) 
http://www.baltimorecityschools.org/boardmaker/adapted_library.asp 
(adapted books) 
       
       OCPS Assistive Technology Team 2004  MP 

Boardmaker related websites (cont’d): 
 

 
Pre-made materials to download: 
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Visual Strategies Supports  
Laminator    USI      800-243-4565 
& Laminating Supplies  98 Fort Path Road 
     Madison, CT 06443-2264 
 
                                                U. S. Office Products (catalog available at most schools) 
 
Boardmaker   Mayer-Johnson Co.   800-588-4548 
Software*, etc.   PO Box 1579 
     Solana Beach, CA 92075-1579 
     www.mayer-johnson.com 
     *OCPS site license #35231, needed for discount price 
 
Velcro    Lockfast-South    770-422-7122 
     2995 Cobb International Blvd. 
     Kennesaw, GA 30152 
 
Call vendors for current prices. 
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